Test file
Instructions are in blue, black text is dummy text.
This is the first page, no header, no footer. Page style is just First Page.
The next page will automatically switch to a page style with Blank page (custom
style created on purpose).

Page left intentionally blank
This test file was created like a report to be printed
double sided, complying with the rule: odd pages are
right and even pages are left.
You should switch to the book view
(status bar at bottom):

White pages with no header/footer are automatically
inserted by AOO
(“blank page” is visible in gray for them in AOO).
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First things first
Pages to add content before your main text (acknowledgments, …).

Note the Roman numbering in the footer.
Pages i and ii are for the blank sheet after the cover page.
You’ll notice that blank pages were automatically added to make odd pages right
and left pages left.
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1. Instructions
The page number and page style are set in the first paragraph of the page. This
can be a direct formatting (Format > Paragraph) or you can include the page
break in the Heading style setting (will apply to all your Heading 1).

Note that the footer is different from the next page (right):

The page count in the footer is the total number of pages of the whole document.

1.1. Heading Level 2
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
Right footer for the main text
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watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?

1.2. Heading Level 2
1.2.1. Heading Level 3
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?
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1.2.2. Heading Level 3
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?
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2. Numbering Pages by Chapter
2.1. Prerequisite
You need to create a page style per chapter to have each total count page field
point to the relevant bookmark.

2.2. Dummy Heading 2
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?

2.2.1. Dummy Heading 3
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
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inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
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inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?

2.2.2. Instructions
This chapter contains 3 pages, see footer.
The section containing the bookmark is below this paragraph. The
characters have been hidden to “hide” the section. To view it again, display
the Non-printing Characters (View menu). Note: you need to have checked
the entries in the menu Tools>Options>OO Writer>Formatting Aids). The
section of the following chapter is identical and has not been hidden.
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3. Numbering Pages by Chapter
3.1. Dummy Heading 2
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?

3.2. Dummy Heading 2
3.2.1. Dummy Heading 3
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
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outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?
He heard quiet steps behind him. That didn't bode well. Who could be following
him this late at night and in this deadbeat part of town? And at this particular
moment, just after he pulled off the big time and was making off with the
greenbacks. Was there another crook who'd had the same idea, and was now
watching him and waiting for a chance to grab the fruit of his labor? Or did the
steps behind him mean that one of many law officers in town was on to him and
just waiting to pounce and snap those cuffs on his wrists? He nervously looked
all around. Suddenly he saw the alley. Like lightning he darted off to the left and
disappeared between the two warehouses almost falling over the trash can lying
in the middle of the sidewalk. He tried to nervously tap his way along in the
inky darkness and suddenly stiffened: it was a dead-end, he would have to go
back the way he had come. The steps got louder and louder, he saw the black
outline of a figure coming around the corner. Is this the end of the line? he
thought pressing himself back against the wall trying to make himself invisible
in the dark, was all that planning and energy wasted? He was dripping with
sweat now, cold and wet, he could smell the fear coming off his clothes.
Suddenly next to him, with a barely noticeable squeak, a door swung quietly to
and fro in the night's breeze. Could this be the haven he'd prayed for? Slowly he
slid toward the door, pressing himself more and more into the wall, into the
dark, away from his enemy. Would this door save his hide?

3.2.2. Instructions
Same as previous chapter, but the section is displayed (gray background). This
chapter contains only 2 pages, see footer.
Section containing the bookmark. End Chapter 3
Note that the paragraph after the section has been hidden with Format >
Character, Font effects > Hidden. To view it, display the Non-printing
Characters (View menu).
Note: you need to have checked the entries in the menu Tools>Options>OO
Writer>Formatting Aids).
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